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Welcome to the vKey Trial Guide! 

This guide will help you quickly get started with your vKey device, 

providing you with the essential steps and tips to make the most of its 

features. 

 
 

Briefly, what is vKey? 

vKey OS is a lightweight, immutable operating system that provides a 

secure environment for delivering applications. It prevents virus attacks 

or malware modifications, making it ideal for handling sensitive 

information. Key features include: 

• Compatibility with remote access systems (e.g., Citrix) 

• Data encryption at rest and in transit 

• Quick setup for trusted, secure endpoints 

• Strong security controls for compliance with data protection 

regulations 
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Minimum System Requirement 

vKey OS can operate under the following minimum configuration. Note 

that the system and most applications will benefit from having more 

than the minimum resources: 

• x86-64 2GHz dual-core processor or faster 

• 2GB System Memory 

• 20GB unallocated drive space 

• VMware Workstation 17 Player or an Oracle VM VirtualBox 7 for 

vKey Virtual Machine (VM) 
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Running your vKey 

In this trial, you can experience both the vKey To Go and vKey VM. 

Please refer to each section to run your vKey device. 

• vKey To Go (USB-A/USB-C) 

• vKey VM 

 

vKey To Go (USB-A/USB-C) 

Running your vKey on vKey To Go is a seamless experience. vKey To Go 

can come in two form factors: USB-A (the left one) and USB-C (the right 

one).  

 

It is the same way to run both types of devices.  

 

On your Desktop or Laptop PC, plug in vKey To Go. 
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Reboot your device using the vKey To Go. Restart your device and keep 

pressing the appropriate key to access the boot menu or BIOS. For 

example, press F12 for Dell laptop.  

Note: Common keys for accessing the BIOS or boot menu include F2, F12 Esc, and Del. 

Please check your device instruction menu for more information.  
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When you see the reboot screen, select the USB disk and press enter. 

 

You will see a black screen with words indicating the vKey is booting.  

 

Then, you will see a vKey booting page with a vKey icon. This booting 

process will take approximately 3 minutes. Enter your password when 

prompted. 
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The vKey To Go is ready now. Please ensure the USB disk is plugged in 

properly during use. Enjoy your vKey! 
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vKey VM 

vKey VM is a vKey Virtual Image that runs on a VMware Workstation 

17 Player or an Oracle VM VirtualBox 7 desktop hypervisor on your 

Windows computer. Please refer to the sections below to run your vKey 

on each platform. 

• vKey VM on VMware Workstation 17 Player  

• vKey VM on Oracle VM VirtualBox 7  

 

 

 

vKey VM on VMware Workstation 17 Player  

To install the VMware-player-17.5.2 on your machine, please kindly 

follow the link below to download the official installer via Broadcom. 

Please note that you will need a Broadcom account to download the 

required installer. 

ProductFiles - Support Portal - Broadcom support portal 

 

On your Desktop or Laptop PC, plug in vKey To Go. You will find a 

mount called VKEY-VM appears in your file manager. Copy the 

folder vkey-vmware to your Windows machine. 

In addition to the hardware requirements of Windows OS, you should have 

additional hardware resources to run the vKey VM. Please consult with 

the Minimum System Requirement section of this guide for more 

information. 

Warning & Advice 

https://support.broadcom.com/group/ecx/productfiles?subFamily=VMware%20Workstation%20Player&displayGroup=VMware%20Workstation%20Player%2017&release=17.5.2&os=&servicePk=520446&language=EN
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After installing the VMware player, open the VMware player, click 

Player -> File -> Open..., and in the file navigator, go to the path where 

you copied the vkey-vmware folder, and open the .vmx file.  
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To run the vKey VM, you can simply double-click the vKey-vmware on 

the side panel or click Play virtual machine. 

 

 

 

Additional steps are available to configure VMware Player 17.5.2 further 

and enhance performance. Please refer to Appendix A for more 

information. 
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vKey VM on Oracle VM VirtualBox 7 

Please visit the official Oracle VirtualBox website to download the latest 

VirtualBox package and the accompanying VirtualBox Extension Pack. 

Downloads – Oracle VirtualBox 

 

Open the vkey-virtualbox folder on VKEY-VM and double-click 

the vkey-virtualbox image to import it with VirtualBox. The VirtualBox 

application will then load the vKey virtual machine. 

Alternatively, you can open VirtualBox, click File -> Import Appliance..., 

and import the vkey-virtualbox image. 

 

 

 

Once the vKey VM is loaded, it will appear in the side panel of 

VirtualBox. To start the VM, simply select it from the side panel and 

click Start. 

https://www.virtualbox.org/wiki/Downloads
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To edit the virtual machine, select it from the side panel and click 

Settings. 
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Getting started with vKey OS 

Getting started with vKey OS is easy. When you first receive a vKey 

device from your organization, your device will most likely be in an 

unactivated state. 

 

Unactivated vKey is clearly marked with the following watermark: 

 

 

 

You will not see the special watermark if your system administrator has 

already activated your device. In this case, you can go straight to the 

"Using your vKey" Section. 
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About Your Trial Activation 

Please note that your vKey device will be activated under the special 

trial account provided by DLS. The trial activation license expires 

automatically in 15 days.  

DLS also monitors and collects various activity data for our trial devices 

for continuous product enhancement. 

 

Activating your vKey - Step 1 

On your vKey, connect to a Wi-Fi Network or Ethernet.   
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Activating your vKey - Step 2 

Open a browser, go to vKey Device Manager (VDM) at 

https://vdm.vkey.ca, and log in with the trial account. 

 

Please find the account information provided in the vKey Trial 

Activation email.  

 

 

 

 
  

https://vdm.vkey.ca/
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You will be prompted to activate the Multi-Factor Authentication (MFA) 

with Microsoft Authenticator. 

Open your Microsoft Authenticator, select “Other”, then scan the QR 

code on the screen. 

 

 

 

You will see the authentication code in the Authenticator app. Put the 

code in vDM, and you are successfully logged in! 
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Activating your vKey - Step 3 

On the vDM home page, enter the trial activation code and click 

"Activate".  Please find the activation code provided in the vKey Trial 

Activation email. 

 

 

 

Activating your vKey - Step 4 

Restart your machine and you are good to go! 
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Using your vKey 

Once activated, your trial vKey device will be directed to the Single 

Application Mode (S.A.M.). 

Single Application Mode (S.A.M.) 

This is a simplistic, lockdown, application centric mode where you can 

access your applications that are managed by your system 

administrator. 
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S.A.M. Desktop 

Applications available on your device are shown in the highlighted 

section. You can launch applications with a simple mouse click. 

To access Citrix Cloud: 

• Please find the DLS demo server and account information 

provided in the vKey Trial Activation email.  

To use Microsoft Windows on Azure Virtual Desktop: 

• Please find the account information provided in the vKey Trial 

Activation email. 
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System language can be toggled (English <--> French). 
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System configurations, robot, power-off. 
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When an application is launched, a configuration button becomes 

available.  

This button is both draggable and expandable, allowing you to exit the 

launched application and access all system configurations. 
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Turning Your Device into a vKey 

Additionally, you can also install vKey OS to your machine's hard drive 

with the vKey Trial device. 

 

 

 

Boot in with vKey To Go and log in to your account on vDM. Navigate to 

the All section by clicking the panel highlighted in red. 

 

 

 

Installing vKey OS directly on your machine will reformat the hard drive. This 

process will cause permanent data loss and is not recoverable. Make sure 

you have backup for your important data! Additionally, the build process can 

only be done through an activated vKey To Go. 

Warning & Advice 
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Click the Build button. 

 

 

 

A confirmation window will spawn as follows: click Build to proceed.  
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Then, click on the “Exit App” button on the configuration button to 

return to the home page. 

Select a target medium. If your target medium is not listed, you can 

click Refresh Disk to re-detect disks. 

 

 

 

Click Next to proceed to install vKey OS on the target medium.  

 

 

Please note that by clicking Next, all data on the target medium will be deleted. 

Warning & Advice 
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Wait for the installation to complete (approximately 3 minutes). 
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After the installation is complete, click Done to close the interface. 

Reboot your device and enter the BIOS to change the boot order if 

needed. 
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Appendix A – Optional Steps to 

Configure VMware Player 17.5.2 

To create share drives so vKey can communicate with your Windows 

Host, you can select vkey-vmware on the side panel and click Edit 

virtual machine settings -> Options -> Share Folders and follow the 

wizard. 
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If you experience performance issues with VMware, the following steps 

can help to improve the performance. 

 

If you are using a laptop, plugging it in and setting the power 

management to Best performance mode can help improve VMware 

performance. 

You can access the Power and sleep settings by right-clicking the 

battery icon in your Windows taskbar. 
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Users should disable Hyper-V on their machine, as it is known to 

conflict with VMware hypervisor. 

 

To disable or verify Hyper-V is disabled, search Turn Windows 

features on or off in the search bar beside the Windows menu key. 

 

 

 

Ensure the Hyper-V option is disabled (unchecked), if the option is 

previously checked, unchecking the option will require you to restart 

the computer.  
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Users are recommended to run the following command as 

administrator to turn of CPU power throttling on vmware. It is known to 

cap CPU usage of the program, causing the VM to run slow: 

 

powercfg /powerthrottling disable /path "C:\Program Files 

(x86)\VMware\VMware Player\x64\vmware-vmx.exe"  

 

Search 'Powershell' in the search bar beside the Windows menu key. 

Make sure to run the Powershell as an administrator. 
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Enter the command mentioned and hit Enter. 
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About DLS 

 

DLS Technology is a leading provider of Cybersecurity, Cloud Computing, Infrastructure and 

Virtualization Integration Solutions and IT Consulting services, product research and 

development for both public and private sector clients. DLS Technology designs, deploys, 

and supports end-to-tend secure enterprise and workspace solutions, including DLS' 

patented vKey Endpoint Cybersecurity solution. Since 2000, DLS has delivered hundreds of 

enterprise level projects that have reduced client's Total Cost of Ownership by an 

estimated 40% and has accelerated client's productivity by an estimated 500%. Visit 

www.dlstech.com and www.vkey.ca. 

 

©Copyright 2025 DLS Technology Corporation. All rights reserved. vKey® is a registered 

trademark of DLS Technology Corporation.  

 

 

http://www.dlstech.com/
http://www.vkey.ca/
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